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We took the kids to the drive-in theater recently. 
Yes, we still have one of these dying breeds of 
theaters near us. They had only been once before 
(during the pandemic), and they have been 
clamoring to go see another movie at the drive-
in theater.

We chose to go see the new “Twisters” movie. 
We didn’t stop to consider that this was the 
movie’s opening night. The drive-in theater was 
packed with movie goers.

One of Ryan’s favorite movies (at almost 11 
years old) is the original Twister movie, starring 
the late Bill Paxton and Helen Hunt. He is 
fascinated by tornadoes. How convenient, since 
we live in “Tornado Alley.” He definitely wasn’t 
disappointed by this sequel to the original 
movie. I have to agree. It was pretty good.

I have a real soft spot for the drive-in theater. 
When I was 13 years old, I got my first real job 
working at the drive-in theater. I worked on the 
“day crew,” which was responsible for cleaning 
up the expansive parking lots and the 
bathrooms. Later, when I was 15, I went to work 
in the concession stand. I also did the marquee 
every week as the movies changed. For a while, 
I worked at two drive-in theaters in the same 
chain at the same time.

It’s amazing how similar a trip to the drive-in 
theater is and how much it differs from all those 
years ago. The “feel” of being at the drive-in

 

theater is remarkably the same as it was nearly 
50 years ago. But now gone are the totally awful 
monaural speakers, replaced by a low power FM 
simulcast that you can listen to over your car 
stereo, or on a portable radio. The sound quality 
is quite decent, especially compared to those 
tonally-challenged monaural speakers.

Since we have an inflatable mattress we place in 
the bed of the pickup truck (which is where the 
kids lie and watch the movie, and it’s made 
especially for use in the bed of a pickup truck), 
we use the portable radio method. We actually

use two portable radios, one in the bed of the 
truck where the kids are lying on the mattress, 
and another on the tailgate so mom and I can 
hear the movie well. For what it’s worth, Laura 
and I sit on chairs outside of the truck.

And, there are the same annoyances. People 
driving through after dark … and after the 
movie has started … with their lights on. The 
idjit two rows up from us who keeps tapping on 
his brake pedal. The incessant talking of the 
movie goers around you. “Parents” who let their 
children run feral. I think you get the picture.

From The Chief Editor's Desk
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Even with all of those annoyances, we find a trip 
to the drive-in theater an enjoyable experience. 
There’s little else that compares to sitting out 
under the stars, watching a movie as a family. 
Plus, it’s a LOT more affordable than going to 
an indoor theater. To start with, and to avoid the 
overpriced food in the concession stand, we 
bring our own drinks, snacks and popcorn. The 
cost of admission is only $25 per car, and they 
usually show two movies. That means if there is 
only one person in your car, or 12, the cost is 
still only $25.

Oh … and as far as the movie is concerned … 
Twisters is DEFINITELY worth seeing!

********************

This month’s cover was created by parnote. The 
base image is by Sebastian Nikiel from Pixabay, 
and I added the “embellishments” to the interior 
of the ice cubes.

********************

Until next month, I bid you peace, happiness, 
serenity, prosperity, and continued good health!

SSccrreeeennsshhoott  SShhoowwccaassee

Like Us On Facebook!

The PCLinuxOS Magazine

PCLinuxOS Fan Club

Linux DocsLinux 
Man Pages

The PCLinuxOS Magazine
Created with Scribus

Posted by astronaut, July 1, 2024, running Openbox.

From The Chief Editor's Desk
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https://pixabay.com/users/dragon77-7686405/?utm_source=link-attribution&utm_medium=referral&utm_campaign=image&utm_content=6215207
https://pixabay.com/photos/ice-artificial-ice-studio-ice-macro-6215207/
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by Paul Arnote (parnote)

As you can imagine, as the magazine’s Chief 
Editor for the past 15 years, I care a LOT about 
fonts. I have a lot of regard for the fonts 
installed on my computer, mostly because I tend 
to use them when putting the magazine together. 
Personally, I have just a small handful of fonts 
that I routinely use for my daily activities, but 
that’s not always the case when producing the 
magazine.

One of the things I miss from my time with 
Windows (the last version I used as a “daily 
driver” was WinXP) is the ability to double-
click my mouse on a font (*.ttf or the newer 
*.otf) file, and a sample of that font is displayed 
in Windows Font Viewer. As a side note, I also 
“used” Windows 7 when I worked in the 
hospitals, but they were so locked down, it was 
more like using a “dumb terminal.”

Of course, I started my search for a font viewer 
by looking in the PCLinuxOS repository. But I 
found only one program that even came close, 
but it felt like overkill. I knew *someone* must 
have wanted or needed a simple font viewer 
besides just me, so I took my search online. 
Believe it or not, there’s not much available for 
Linux. Most of what I found was for Windows.

Ever since coming over from the “dark side” of 
computing (Windows), I’ve casually searched 

for a simple way to view a sample of font files. 
It wasn’t until just recently that I discovered not 
one, not two, but three methods of viewing font 
file samples.

Sure, you could open a blank word processing 
document and play with fonts there. But, if I just 
want to see what a font looks like, this seems 
like a very arduous and tedious task. I might be 
trying to see if I want to install a particular font 
on my computer, and any word processor 
program is only going to show you fonts that are 
already installed on your computer. Being able 
to simply view what a font looks like, without 
installing it on your computer, was beginning to 
look like a difficult task to conquer.

Fontmatrix

Fontmatrix is the one program that is in the 
PCLinuxOS repository that’s specifically for 
dealing with font files installed on your 

computer system. And, while very capable, it 
seems a bit like overkill for what I’m looking 
for. It actually may not be overkill, but 
something about it just “feels” like overkill. I’m 
all for keeping things simple, and Fontmatrix 
feels like anything but simple.

In the image above, Fontmatrix displays all of 
the fonts already installed on your computer. If 
you click on the “Browse Directories” button in 
the lower right corner of the Fontmatrix window, 
you can import fonts from other directories into 
your font collection. To be perfectly honest, I 
don’t know if it just adds it to your catalog of 
fonts in Fontmatrix, or if it installs them on your 
system at the same time.

Double-clicking on a font in the first image 
loads the entire font family into Fontmatrix, and 
causes it to switch to the “Sample” tab. Select 
which member of the font family you want to 
view, and the sample text is displayed in your 
selected font. You can adjust the display size at 

The Easiest Ways To View/Sample Font Files
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the bottom center of the window, by adjusting 
the number in the “Font Size” setting. The full 
name of the selected font is shown in bold at the 
lower left corner of the window.

Selecting the “Chart” tab, Fontmatrix will 
display all of the characters in the selected font 
file. It also displays the “name” of the character, 
the Unicode hexadecimal value for that 
character, and the ASCII keycode for each 
character.

Clicking on the “Info” tab will reveal all of the 
font information, such as who owns the 
copyright, who made the font, and all sorts of

information that most people never even think 
about with font files.

Under the “Activation” tab, you have 
(presumably) the option of activating or 
deactivating an installed font on your computer. 
You can remove individual members of a font 
family, or the entire font family.

Under the “Edit” menu, there’s the 
“Preferences” option. Selecting it will bring up 
the first dialog, shown above. In both of the first 
two settings, I’ve left everything at their default 
values. The selections should be self-
explanatory.

The next section, named “Display,” contains the 
settings for the display of the font names in 
Fontmatrix’s main window, as well as the font 
on the “Chart” tab. As far as I can tell, the 
default value of <name> tells Fontmatrix to use 
the font name to display the sample in the main 
Fontmatrix window.

The “Service” section makes a few choices 
available to the user. If you have the FontForge 
font editor installed, you can point to the 
location where that is installed. The “Help 
Browser” section tells Fontmatrix if you want 

The Easiest Ways To View/Sample Font Files



PCLinuxOS Magazine Page 7

the Help file open in a Fontmatrix window, or in 
your browser. If you have a “Hyphenation 
dictionary” installed for LibreOffice, you can 
point Fontmatrix to that dictionary.

Just a word about the Help file, by the way. 
When I pulled it up, it didn’t match up with 
what I was seeing in the Fontmatrix window. 
For example, my copy of Fontmatrix has five 
menu items in the main window, while the help 
file lists seven. So, immediately, I notice that the 
two don’t match up, significantly decreasing the 
usefulness of the help file. The help file talks 
about one entry in particular (the “Browse fonts” 
sidebar), which is nowhere to be found in my 
copy of Fontmatrix. It’s a shame, because that 
particular feature sounded like it might be 
something I might find interesting and useful.

I thought perhaps there have been later releases, 
but then I compared the version I have installed 
on my computer with the latest version available 
on GitHub. Nope. That’s not it. The version 
from the PCLinuxOS repository is the latest 
version available from GitHub. So, I have no 
explanation for why the help file doesn’t match 
up with the installed version of Fontmatrix.

The “Samples collection” is where you set the 
text that is displayed on the font sample page. 
Type in whatever you want into the text entry 
box (bottom left side of the right pane), and then 
select the “Save” button. You can even enter 
Lorem Ipsum text (you can find examples on the 
internet, courtesy of your favorite search engine 
… here’s one I used).

In the “Files & Folders” field, I’ve left 
everything at their default values, as pictured 
above.

Under the “Shortcuts” section, you can set your 
own keyboard shortcuts for interacting with 
Fontmatrix. A few come predefined, and you can 
change them to shortcuts that better correspond 
to how you work (if you want). I’ve also left all 
of these at their default values.

Verdict: Fontmatrix is a good program, but it 
feels like it has been overcomplicated, like 
someone spent way too much time overthinking 
things. The “missing” items from the program 
that are discussed in the help file are pretty 
discouraging, and that alone doesn’t give me a 
lot of confidence. While it’s great for viewing 
fonts on my system … both installed and 
uninstalled … it still isn’t the “simple” solution 
I’ve been searching for. Plus, I don’t think I need 
to give up 83.2 MB of storage space for the 
program. Grade: C-.

Looking for an old article?
Can't find what you want?

Try the PCLinuxOS Magazine's 
searchable index!

The Easiest Ways To View/Sample Font Files
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https://github.com/fontmatrix/fontmatrix
https://loremipsum.io/generator/?n=5&t=p
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Gnome Fonts Viewer

During my search for a font viewer, I kept 
coming across people talking about Gnome 
Fonts Viewer. Well, lo’ and behold, wouldn’t 
you know that it exists as a flatpak package. I 
went and grabbed the flatpak, and was 
pleasantly surprised that a) it ran at all, and b) 
that all of the functions of Gnome Fonts Viewer 
worked exactly as they should. If you need to 
review how to install a flatpak file, take a look at 
the article we ran on Flatpak and AppImage files 
here.

The main window (shown above) lists all of the 
fonts it can find on your system. Each font is 
represented by “Aa” displayed in each font, with 
the font name just below it.

Double-clicking on a font in the main window 
will open that font with the sample text “The 
quick brown fox jumps over the lazy dog.” 
already displayed, in several different font sizes. 
The name of the font appears at the top of the 
window.

Notice how in the first image, the button at the 
top of the window says “Installed.” But, in the 
second window, that same button has changed to 
a blue button that says “Install.” If you click on 
the “Install” button, that font is then properly 
installed on your system, and it appears in /usr/
share/fonts, typically in its own directory. The 
“Install” button installs all members of that font 
family, not just the one font family member that 
you happened to be viewing at that moment.

Selecting the “Info” button at the top of the 
program’s window displays all the information 
about that font, that’s stored within the font file, 
as shown above. The second item listed in the 
“Info” listing is the path to where that particular 
font file is stored on my computer.

Want to keep up on the latest that's
going on with PCLinuxOS?

Follow PCLinuxOS on Twitter!

http://twitter.com/iluvpclinuxos
The place where breaking news, 
BitTorrent and copyright collide

The Easiest Ways To View/Sample Font Files

http://twitter.com/iluvpclinuxos
http://torrentfreak.com/
https://pclosmag.com/html/Issues/202304/page03.html
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The “About” dialog for Gnome Fonts Viewer

Verdict: Gnome Fonts Viewer has all of the 
features of Fontmatrix that I care about, but 
presented in a much simpler GUI. I can install 
any fonts I come across that I want to keep on 
my system, without having to go into Configure 
Your Computer (PCC) to do the installation 

from there. Still, it’s overkill for what I’m 
looking for. And, I’m not sure I really need to 
relinquish 351 MB of storage space (the final 
size after installed from the flatpak) just to view 
a font file. Still, it has a lot going for it, even 
beyond its simpler, less cluttered interface. 
Grade: B+.

Using What You Already Have

There’s something to be said for the K.I.S.S. 
principle. When I was teaching respiratory 
therapy, I used a modified version of K.I.S.S. 
with my students: Keep It Super Simple. The 
simplest answer is/was usually the right course 
of action. Just as with my students, I explained 
that none of them were stupid, so I changed up 
the words for the acronym. None of you are 
stupid either, so I feel better using my modified 
version of K.I.S.S. with y’all, as well.

WHAT IF you discovered that you already had 
everything you needed already installed on your 
computer to create a very simple and effective 
font viewer? When I discovered this, I was 
amazed to find out I had this ability all along, 

but never knew about it. I was in awe at how 
easy it was.

During my search for a solution, one small entry 
from StackExchange caught my eye (it’s the 
third solution down). I was stunned! Certainly, it 
can NOT be THAT easy!

Just about every PCLinuxOS user has 
ImageMagick installed on their computer (and if 
you don’t, you should have this graphics 
powerhouse at your disposal). ImageMagick 
continues to amaze me with its abilities. One of 
the programs in the ImageMagick suite of 
programs is called display.

The “pot” keeps getting sweeter for the use of 
the display command to serve as our font 
viewer. ImageMagick’s display command can 
open TrueType font files (*.ttf), OpenType font 
files (*.otf), and PostScript Type 1 files (*.pfb). 
PFB stands for PostScript Font Binary, and they 
are older than TTF and OTF font file formats, 
and are heavily tied to Adobe. PostScript Type 1 
files came out in 1984. TTF files came out in 
1991, developed by Apple. OTF files came out 

The Easiest Ways To View/Sample Font Files

https://unix.stackexchange.com/questions/5715/how-to-view-a-ttf-font-file
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in 1996, as a joint venture between Microsoft 
and Adobe.

For what it’s worth, neither Gnome Font Viewer 
nor Fontmatrix appear to be capable of viewing 
PFB font files. It is, however, no problem at all 
for using ImageMagick’s display command.

Keep in mind that I use the Xfce desktop 
exclusively, so my images and approach reflect 
how to set this up under that desktop. However, 
it should be a trivial task to do the same or 
similar thing under other desktops, like Mate, 
KDE, LXQt, etc.

In the image above, find a font file on your 
system (in this particular image, it’s a PostScript 
Type 1 *.pfb file), right-click on the file, select 
“Properties,” drop down the list under “Open 
With…”, and select “Use a custom command.” 
Then, in the text box, type display %, and then 
the “OK” button. Repeat these steps for samples 
of the TTF and OTF files on your computer.

Now, whenever you double-click on any of 
these font files, you will get the first image 
shown in this section of the article, showing you 

a sample of the selected font in the 
ImageMagick window that appears.

That sample, for what it’s worth, is a PNG 
graphic file! Right-click your mouse anywhere 
within that image, and navigate to “Save…” in 
the context menu.

Now, type the filename you want to save this 
image as (I used UniversLTStd.png), and you 
can save the image to your hard drive. This 
makes it super easy to create a catalog of your 
fonts. The images are all the same size (800 x 
480), so all you have to do is save an image for 
each font file, and then combine them all into a 
PDF file. To create that PDF file, probably one 
of the easiest ways is to load each image into 
LibreOffice Writer, and then output it as a PDF 

file. Ideally, you’d probably want only one or 
two images per page of your catalog.

The text displayed by the use of the display 
command appears to be predefined (“That which 
does not destroy me, only makes me stronger.”). 
To me, that sounds just as good as “The quick 
brown fox jumps over the lazy dog.” or any 
other sample text. While it is possible to change 
that text, in the end, you lose the display of the 
sample text in multiple sizes. I’ve not yet 
figured out how to make it mimic the display of 
the default text, with multiple font sizes. As a 
result, I don’t try to redefine that sample text, 
because I like seeing a representation of the font 
at different font sizes.

If you’re interested, there is a sample script from 
the ImageMagick legacy website that resets the 
sample text. But, it also doesn’t present font 
samples in different sizes. Even though the 
sample script appears to be somewhat 
unfinished, it does run perfectly, as is (there are 
options in the script that are never accessed, as if 
the plan was to implement them but, in the end, 
they were not implemented). Just save it to 
where you save your bash scripts, and mark it as 
an executable file. To make it even more useful, 
use this command line syntax (should you 
decide to give this sample script a try): show-
fonts.sh -2 -p 48 [name-of-font-file]. I’ve got it 
saved on my computer. It may come in handy 
when/if I figure out how to replicate the display 
of the fonts in multiple font sizes.

Verdict: This is EXACTLY what I’ve been 
looking for ever since I switched from being a 
Windows user to being a Linux user. I love that 

The Easiest Ways To View/Sample Font Files
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it works for ALL types of font files, too. Even 
Gnome Fonts Viewer had difficulty displaying 
PostScript Type 1 font files. My only complaint 
about this method is that ImageMagick uses 
more of the X-Windows styled dialogs to save 
the PNG files, almost as if they are 
“homegrown” in appearance, instead of using 
the Gtk+ or Qt styled dialogs that we are more 
accustomed to. The dialog boxes used in this 
manner are not as intuitive or easy to navigate as 
the Gtk+ or Qt styled dialog boxes that we’ve 
become used to.

While this method does NOT allow me the 
option of installing a font, I’m more than ok 
with that. Much of the time, I’m merely wanting 
to VIEW a font file. I may view 20 or more font 
files before finding the ONE that I want to 
install. To install the selected font, it’s a trivial 
matter to switch to another program … 
Fontmatrix, Gnome Fonts Viewer and PCC all 
work well for this … and install the font (or font 
family) to my hard drive for use. What I like 
most is that this method uses what I already 
have installed on my system (ImageMagick), 
with no other software needed. Grade: A+.

Conclusion

Now, you have at least three different programs 
to use to view font files. I can’t believe that it 
took me THIS LONG (I’ve been using Linux 
since at least 2006, and PCLinuxOS since 2007) 
to find a replacement for Windows Font Viewer. 
And, for all this time, I had the solution installed 
on my computer all along!

SSccrreeeennsshhoott  SShhoowwccaassee

Posted by DrMop, July 13, 2024, running Xfce.

The Easiest Ways To View/Sample Font Files
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by Meemaw

I’ve seen another tutorial I think is fun! This one 
is from Rick at IronEcho Design, on how to 
bend text around a corner. He has some cool 
tutorials, and especially the ones he’s seen as 
Adobe Illustrator tutorials, and then figured out 
for Inkscape.

It’s kind of fun as well! 

Start by opening Inkscape and editing your 
document properties so your page has a black 
background and is in Landscape orientation. He 
suggests size B1 (which is 700 px by 1,000 px).

The next thing to do is to create a 3D box using 
the 3D Box tool. You can make it however you 
want. My first try used the box that you see 
here, where the bottom isn’t visible (center, top).

On the box you’ll see a number of nodes that 
you can use to edit the box, but first, grab the 
“X” (you can see it in the left-hand surface), and 
move it around. You can manipulate it so the top 
or bottom is visible, it is closer or farther, or 
anywhere on the page. Also, in the toolbox 
above you’ll see Angle X, Angle Y and Angle Z. 
X is the left side horizon (where the lines come 
together for perspective), Y is the horizon at the 
top, and Z is the right side horizon. Notice that 
the lines at the top are parallel, meaning that the 
Y perspective in an object this close to us is 
generally almost infinite. Anyway, for the 
purposes of this project, the setting for Y needs 
to be the parallel lines (so the front of the box is 
absolutely vertical).

When you get it shaped the way you want it, 
change to the Selection tool, make the box 
bigger if need be, then click Path > Object to 
path. You’ll notice at the bottom of the window 
that Inkscape says “Group of 6 objects in layer

Layer 1” (meaning that the box is a group of 6 
objects (sides) in the layer named Layer 1). 
Since we can’t see the back of the box (and 
depending on how you drew it, we might only 
be able to see 2 sides), we can ungroup the sides 
and delete the ones we don’t need.

Select the box and click Object > Ungroup (or 
use the tool at the top). You’ll see something like 
this:

Every side has an outline, so click away from 
the box, then, holding down the <Shift> key, 
select the ones you want to keep and move them 
away from the others. In this case, the left and 
right sides and the bottom would be the only 
ones that would be visible to put text on, so save 
them and delete the other three. In the image 
below, we want the left group, and I’ll delete the 
others (next page, top left).

Inkscape Tutorial: Bending Text Around A Corner

https://www.youtube.com/@IronEchoDesign
https://www.youtube.com/watch?v=tMjJbS-rvj0
https://www.youtube.com/watch?v=tMjJbS-rvj0
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OK, now for the text. You can use any font you 
want, but these kinds of projects seem to work 
best with bold fonts. I used Bitstream Vera Sans 
Bold, around 150 pt, and reduced the space 
between the lines to .80 pt. Type your text, but 
since you are putting it on the surface of the box, 
you should probably make it more than one line.

PCLinuxOS
IS THE BEST!

When you get your text edited the way you 
want, change to the Selection tool and click 
Path > Object to path. With your text still 
selected, choose Path > Path Effects. When 
you get your menu, add the path effect Slice. 

When you choose the Slice effect, you’ll see that 
the box around the text has changed to being 
around the left half of the text. You may like that 
slicing point, but if not, there is a way to change 
it. Go to your nodes tool, grab the center node in 
that line, and move it left or right. Rick at 
IronEcho urges you to cut your letters 
somewhere other than exactly in the center, 
because it seems to look better.

Then you can change back to the Selection tool 
and move your text apart.

Now we work the magic. Choose the left side of 
the box and the left side of your text. Go to 
Extensions > Modify Path > Envelope 
Deformation. Your text should jump onto the 
box face selection. NOTE: If you get an error 
message about one of your selections being a 
group, it’s probably the text. Inkscape made my 
text of two lines a group of 2 paths. The solution 
is to ungroup them, then click Object > Union. 
Go back and select the text and the box face, 
and go back to Extensions. It should work now.

Inkscape Tutorial: Bending Text Around A Corner



PCLinuxOS Magazine Page 14

Using the same steps, do the right side. 
BEFORE you enable the extension, your text 
needs to be manipulated a bit — something 
about how the 3D Box tool works. If you leave 
the text as it is, it will be turned wrong on the 
box face. Do a horizontal flip, and then rotate it 
90o to the left, and then it will look right. You 
might also have to move the text a tiny bit to 
line it up with the left face.

You can change the text color depending on 
which way the light is coming from as well. I 
left the left side while, but changed the right side 
to a medium gray, then I deleted the box faces.

My next try showed the bottom of the box as 
well. When you put the text on the bottom, you 
only have to rotate it 90o to the right. Have fun!

Inkscape Tutorial: Bending Text Around A Corner
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Serves: 4

INGREDIENTS:

4 TBSP butter (unsalted)
3 TBSP mayonnaise
1/2 cup Parmesan cheese
1/2 tsp old bay seasoning
1//4 tsp dried basil
1/8 tsp celery salt
1/8 tsp onion powder
1/4 tsp black pepper
fresh lemon juice
tilapia filets – Try to find fresh filets as they
       tend to be larger than flash frozen.
Minced parsley – Optional, for serving.

DIRECTIONS:

Preheat your broiler and line a cookie sheet with 
foil and lightly spray with olive oil.

In a small bowl mix together; butter, mayo, 
Parmesan, Old Bay, basil, black pepper, onion 
powder and celery salt. Squeeze in the juice of 
half a lemon and set aside.

Arrange the tilapia with the dark vein (bottom) 
side up and broil all fish together for 3 minutes.

Remove and carefully flip the fish so they are 
now right side up.

Divide the Parmesan mixture over each filet and 
slide back into the oven for 3 more minutes, or 
until the fish is opaque and flakes easily, and the 
topping is golden and bubbly.

Serve with a sprinkle of Parmesan cheese and 
minced parsley.

NUTRITION:

Calories: 392      Carbs: 2g         Sodium: 538mg
Fiber: 0.1g          Protein: 383

PCLinuxOS Recipe Corner

Broiled Tilapia Parmesan
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by Paul Arnote (parnote)

Microsoft has been charged by the EU for 
breaking antitrust rules. The European 
Commission claims that by bundling Teams into 
the Office 365 and Microsoft 365 suites, the 
company disproportionately restricts 
competition in the market for communication 
apps, according to an article from TechRepublic. 
The primary reason for this is because 
Microsoft’s suite of business productivity tools, 
like Excel, Outlook and PowerPoint, is the 
second most popular worldwide after Google 
Workspace. Therefore, when Teams is included 
with 365 by default, it gives the company a so-
called “distribution advantage.” Customers are 
unlikely to seek out another communications 
app if they have invested in the 365 tools, and 
Teams comes with them automatically. Any 
interoperability limitation between Microsoft’s 

offerings and Teams’ competitors exacerbates 
this issue.

Apple has become the first tech giant to be 
formally charged by the European 
Commission for violating the Digital Markets 
Act, according to an article from TechRepublic. 
A preliminary ruling was made on June 25, 
2024, and the Cupertino firm could be handed a 
hefty fine as a result. The Commission has 
found that Apple has three sets of business rules 
that ultimately prevent iOS app developers from 
directing their users towards third-party 
purchase options. This goes against the DMA, 
which states that developers should be able to 
steer their customers towards purchasing options 
outside of the App Store easily and free of 
charge. Apple takes a 30% commission from the 
revenue of any in-app purchases, so when users 
make app-related payments on their phone 
browser, for example, it eats into its profits.

On July 1, 2024, Meta became the second 
company charged with violating Europe’s 
Digital Markets Act, one week after the EU 
threatened Apple with a $38 billion fine, 
according to an article from Lifehacker. While 
Apple’s charge focuses on its treatment of 
outside payment methods and third-party apps, 
Meta’s is all about its big money maker: ads on 
Facebook and Instagram. Throughout most of 
the world, Meta monetizes its sites using 
targeted ads, which means it harvests your data 
to focus your ads on your interests. To attempt to 

appease the DMA’s privacy regulations, the 
company lets European users subscribe to an ad-
free plan for €9.99 per month (more if you add 
linked accounts or subscribe using an app store), 
but the region is now saying this isn’t enough. In 
a preliminary ruling posted to its site today, the 
European Commission said Meta must also 
allow users to access a third option, which 
should be a free plan that would still show ads 
but use less personal data.

Glibc-based Linux systems are vulnerable to 
a new bug (CVE-2024-6387) in OpenSSH's 
server (sshd) and should upgrade to the latest 
version, according to an article from The 
Register. Infosec researchers at Qualys 
published their findings today, revealing that 

ICYMI: SSH Server Bug Opens Vulnerabilities

https://www.techrepublic.com/article/microsoft-charged-eu-antitrust-teams/
https://www.statista.com/statistics/983299/worldwide-market-share-of-office-productivity-software
https://www.techrepublic.com/article/apple-eu-digital-markets-act/
https://lifehacker.com/tech/meta-faces-potential-134-billion-fine-from-eu
https://lifehacker.com/tech/apple-charged-with-breaking-eu-dma-rules
https://www.facebook.com/help/1241090626576242
https://www.theregister.com/2024/07/01/regresshion_openssh/
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sshd is vulnerable to a race condition that could 
allow an unauthenticated attacker to achieve 
remote code execution (RCE) on potentially 
hundreds of thousands of targets. Successful 
exploitation could give intruders root-level 
access to a system, allowing them to potentially 
get away with virtually anything. Of the 14 
million possibly vulnerable sshd instances that 
show up on Censys and Shodan scans, Qualys 
believes that roughly 700,000 of these internet-
facing instances could feasibly be hit by 
regreSSHion – the name researchers gave to the 
flaw based on its roots. Never fear … Texstar 
has already patched OpenSSH and the SSH 
server software the PCLinuxOS repository.

This ought to make it evident that big tech is 
playing with two sets of rules: one for them, and 
another for the “rest of us.” Content that has 
been posted on the open web should be 
treated as “freeware”, according to 
Microsoft’s AI chief, in an article from Forbes. 
That being the case, he appears to have just 
ripped up the licensing agreement for software 
such as Microsoft Windows and Office. Mustafa 
Suleyman, the CEO of Microsoft AI since 
March this year, made his eyebrow-raising 
comments during an interview with CNBC. 
Asked if the training of AI models on internet 
content was tantamount to intellectual property 
theft, Suleyman made the argument that 
anything posted on the web was fair game. "I 
think that with respect to content that's already 
on the open web, the social contract of that 
content since the nineties has been that it is fair 
use,” said Suleyman. “Anyone can copy it, 
recreate with it, reproduce with it. That has been 
freeware, if you like, that's been the 

understanding." So all those versions of 
Windows and MS Office posted to the web are 
FREEWARE? If you try it (playing by the 
“rules” he proposes), be prepared to be 
contacted/visited by Microsoft’s legions of 
overpaid lawyers.

Enterprise software vendor HubSpot says it’s 
“actively investigating and blocking 
attempts” to hack into customer accounts and 
warned that at least 50 HubSpot targets have 
already been breached, according to an article 
from SecurityWeek. “While our investigation is 
still underway, we believe based on our initial 
assessment that the bad actors were able to gain 
unauthorized access to less than 50 HubSpot 
accounts,” HubSpot said in a brief notice posted 
online. The Cambridge, Mass.-based HubSpot, 
which sells specialized tools for sales and 
marketing teams, said the unidentified hackers 

are continuing to target a limited number of 
HubSpot customers and attempting to gain 
unauthorized access to their HubSpot accounts.

Image by Elchinator from Pixabay

According to a report from Korean news agency 
JTBC, users of torrent-based "webhard" 
services—file storage and transfer platforms 
that are popular in South Korea—began 
reporting in 2020 that they were experiencing 
slow transfers, busted files, and 
malfunctioning PCs, says an article from PC 
Gamer. When one of the webhard providers 
noticed all the users experiencing issues were 
KT customers, the company reported the 
information to Korean law enforcement. ISPs 
have waged war against torrent traffic for years. 
In the US, before those few years where the 
FCC decided to give things a go without net 
neutrality (it didn't go well), Comcast earned 
itself a cease-and-desist in 2008 after throttling 
BitTorrent transfers. Legal protections and 
networking advances have seen those efforts 
subside somewhat in recent years, making it 
even wilder that Korean police found evidence 
suggesting that KT was distributing malware to 
its own customers as punishment for using P2P 
services.

Defending Your Rights

In The Digital World
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According to an article from TechRadar, threat 
actors are abusing a vulnerability in an 
outdated D-Link router to steal people’s 
sensitive data, researchers have claimed. 
Cybersecurity experts from GreyNoise recently 
reported observing hackers in the wild, abusing 
a critical vulnerability in D-Link DIR-859 Wi-Fi 
routers. The flaw is described as a path traversal 
vulnerability that leads to information 
disclosure, and is tracked as CVE-2024-0769. It 
has a severity score of 9.8/10, and was first 
discovered in January 2024. The vulnerability 
has no patch available.

In a possible glimpse at future internet speeds, 
scientists in Japan recently powered a 402,000 
Gbps connection using commercially 
available optical fiber, according to an article 
from PCMag. The research comes from Japan’s 
National Institute of Information and 
Communications Technology (NICT), which has 
partnered with other labs to use existing optical 
fiber tech to deliver huge speed enhancements. 
In March, one of NICT’s partners on the project, 
Aston University in the UK, beamed internet 
speed at 301,000 Gbps over a single, standard 
optical fiber. NICT has since followed up with 
another test, hitting 402,000. The feat was 
achieved by harnessing additional wavelength 
bands—essentially colors—within the optical 
fibers to increase the data transmission rate. 
Specifically, NICT scientists tapped the O-, E-, 
and S-bands to amplify the data when the C- and 
L-bands are typically used for long-haul 
transmission over fiber networks.

Billions of people use online document editors 
like Google Docs or Microsoft 365 to write 
reports, collaborate on projects, and keep track 
of meeting notes (The PCLinuxOS Magazine 
uses Google Docs for collaborative editing of its 
magazine articles). But there is a growing 
concern about Big Tech platforms having access 
to your content, tracking you across the web, 
and collecting data to train privacy-invading AI 
models. On July 3, 2024, Proton announced a 
new end-to-end encrypted, collaborative 
document editor that puts your privacy first, 
according to an announcement on the Proton 
blog. Docs in Proton Drive are built on the same 
privacy and security principles as all our 
services, starting with end-to-end encryption. 
Docs let you collaborate in real time, leave 
comments, add photos, and store your files 
securely. Best of all, it’s all private — even 
keystrokes and cursor movements are encrypted.

Millions of WordPress websites are under 
threat after a critical security breach 
involving several popular plugins, according 
to an article from eSecurity Planet. Security 
researchers discovered malicious code injected 
into these plugins, granting hackers the ability to 
create unauthorized administrator accounts. This 

compromise can lead to severe consequences for 
website owners, including data breaches and 
total website takeovers. The specific number of 
affected plugins and websites is still under 
investigation. However, initial reports suggest 
prominent plugins with thousands of active 
installations might be involved, raising serious 
concerns about the overall security of the 
WordPress ecosystem and the vulnerability of 
websites built on the platform.

Japan FINALLY phases out floppy disks, 13 
years after the country’s producers 
manufactured them, according to an article 
from the New York Times. One of the world’s 
most technologically advanced nations has held 
on to some of the most outmoded devices. Japan 
scrapped every regulation requiring the use of 
floppy disks for administrative purposes this 
week, catching up with the times 13 years after 
the country’s producers manufactured their last 
units. The floppy disk, invented in the 1970s, 
was once a ubiquitous part of computing. Other 
forms of memory like flash drives and internet 
cloud storage have since taken over. The next 
target for Japan’s war on outdated technology: 
fax machines.

Looking for an old article?
Can't find what you want?

Try the PCLinuxOS Magazine's 
searchable index!
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Google’s latest annual environmental report 
reveals the true impact its recent forays into 
artificial intelligence has had on its 
greenhouse gas emissions, according to an 
article from TechRepublic. The expansion of its 
data centers to support AI developments 
contributed to the company producing 14.3 
million tonnes of carbon dioxide equivalents in 
2023. This represents a 48% increase over the 
equivalent figure for 2019 and a 13% increase 
since 2022. “This result was primarily due to 
increases in data center energy consumption and 
supply chain emissions,” the report’s authors 
wrote. “As we further integrate AI into our 
products, reducing emissions may be 
challenging due to increasing energy demands 
from the greater intensity of AI compute, and the 
emissions associated with the expected increases 
in our technical infrastructure investment.”

As originally reported by TechRadar, 
researchers say they found a text file, called 
rockyou2024.txt, containing nearly 10 billion 
unique passwords, all stored in plain text, 
according to an article from Lifehacker. That 
means anyone with access could scrape the list 
as they would a PDF and discover each and 
every password for themselves. This was not a 
project that happened overnight: These 
passwords were collected over time, from 
various attacks and leaks over the past 20 years. 
Attackers added 1.5 billion of these passwords 
to the file from 2021 to this year alone. The fact 
that these are all unique, too, means there are no 
repeats in the list. It's tough to wrap your head 
around that many passwords.

Are you concerned by what (and how much) 
data Google has collected about you? Would 

you like to have some control over that data, 
including the ability to delete it? If so, then this 
article from Lifehacker is for you! They walk 
you through how to view and possibly delete the 
data that Google has collected on you.

Image by Pheladi Shai from Pixabay

A lawsuit was filed on July 11, 2024, against 
Hershey, Walgreens and several others in the 
case of a Massachusetts teen who died after 
he participated in a spicy tortilla chip 
challenge that was widely promoted on social 
media, according to an article from the 
Associated Press. The teen, a 10th grader from 
the city of Worcester, died Sept. 1, 2023, after 
eating the Paqui chip as part of the 
manufacturer’s “One Chip Challenge.” An 
autopsy found Wolobah died after eating a large 

A magazine just isn't a magazine 
without articles to fill the pages.

If you have article ideas, or if you 
would like to contribute articles to 

the
PCLinuxOS Magazine,

send an email to:
pclinuxos.mag@gmail.com

We are interested in general articles 
about Linux, and (of course), articles 

specific to PCLinuxOS.
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quantity of chile pepper extract and also had a 
congenital heart defect.

Apple actually did send alerts to users on July 
10, warning them they might be targeted by 
"mercenary spyware attacks." According to 
Apple, it sent the alert at 12 p.m. PT on 
Wednesday to users in 92 countries, according to 
an article from Lifehacker.

Handheld phone use while driving is a major 
factor in vehicle crashes, according to one study 
recently published in the JAMA Open Network. 
Scalable interventions are needed to encourage 
drivers not to use their phones. The objective is 
to test whether interventions involving social 
comparison feedback and/or financial 
incentives can reduce drivers’ handheld 
phone use. In a randomized clinical trial, 
interventions were administered nationwide in 
the US via a mobile application in the context of 
a usage-based insurance program (Snapshot 
Mobile application). Customers were eligible to 
be invited to participate in the study if enrolled 

in the usage-based insurance program for 30 to 
70 days. The study was conducted from May 13 
to June 30, 2019. Analysis was completed 
December 22, 2023.

Image by Clker-Free-Vector-Images from Pixabay

As if you really needed it, here’s something to 
make you feel really old. This year marks the 
30-year anniversary of the grill, officially 
known as the George Foreman Lean Mean 
Fat Reducing Grilling Machine, according to 
an article from The Hustle. After a slow start, it 
became an indelible part of ‘90s consumer 
culture and the world’s most popular product for 
cooking hamburgers, hot dogs, salmon, and just 
about everything else (Oprah Winfrey preferred 
it for bacon). Read the article for an interesting 
history of how the grill came about, rose to 
popularity, and remained popular.

AT&T revealed on July 12, 2024, that a 
cybersecurity attack had exposed call records 
and texts from “nearly all” of the carrier’s 
cellular customers (including people on 
mobile virtual network operators, or 
MVNOs, that use AT&T’s network, like 
Cricket, Boost Mobile, and Consumer 

Cellular), according to an article from The 
Verge (and widely reported on in multiple media 
outlets). The breach contains data from between 
May 1st, 2022, and October 31st, 2022, in 
addition to records from a “very small number” 
of customers on January 2nd, 2023.

Inflection AI co-founder Mustafa Suleyman 
joined Microsoft as CEO of Microsoft AI in 
March, and took “several” coworkers with 
him, according to an article from TechRepublic. 
Now, the UK’s Competition and Markets 
Authority (CMA) has opened an inquiry into 
whether this and Microsoft’s other deals with 
Inflection should be considered anti-
competitive. The CMA has until Sept. 11, 2024 
to decide whether to continue the investigation.

Businesses across the world are reporting IT 
outages, including Windows “blue screen of 
death” errors on their computers, in what has 
already become one of the most widespread 
IT disruptions in recent years, according to an 
article from TechRadar (and very widely 
reported on in just about every media outlet). 
The outage — linked to a software update from 
popular cybersecurity firm CrowdStrike — has 
affected computers running Microsoft Windows 
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at organizations across various sectors, including 
airlines, banks, retailers, brokerage houses, 
media companies and railway networks. The 
travel sector seems to be one of the hardest hit, 
based on online chatter.

UPDATE: In a post to its website July 20, 
2024, Microsoft released a file for USB drives 
that can quickly and near-automatically fix 
PCs downed by the CrowdStrike fiasco, 
according to an article from Lifehacker. It comes 
with a fix that does all the work for you but 
requires a BitLocker recovery key (if BitLocker 
is enabled), as well as one that can bypass 
BitLocker but needs you to do a bit more 
legwork. Download the file here and follow the 
instructions to create a recovery key, then pick 
one of the recovery options based on your 
needs. Most users will be better off with the 
automatic option, Recover from WinPE, so start 
there and only move on if you’re prompted for a 
BitLocker key you can’t get. If you need but 
can’t get a BitLocker key, use Recover from safe 
mode instead. It’s more involved, but finally 
offers a way into machines that have otherwise 
been closed off.

If you were looking forward to an internet 
free of cookies, you’ll be sorry to hear this 
bad news: Google is officially canceling its 
plans to kill cookies, according to an article 
from Lifehacker. The company announced the 
decision in a blog post July 22, 2024, citing 
feedback from regulators, publishers, 
developers, and individuals in the advertising 
industry. Google says that, while the company 
still believes it can strike a balance between the 
online ad marketplace and user privacy, it 

understands the existing challenges in doing so 
with this many moving parts. The company 
says, "this transition requires significant work by 
many participants and will have an impact on 
publishers, advertisers, and everyone involved in 
online advertising." As such, Google announced 
it is changing tactics on its privacy plans for 
online advertising: While the company will be 

abandoning its push to retire cookies, it will be 
introducing a new option in Chrome that, "lets 
people make an informed choice that applies 
across their web browsing." Google fell short of 
explaining exactly how this "informed choice" 
works, but users will have the option to change 
their choice at any time.

SSccrreeeennsshhoott  SShhoowwccaassee

Posted by The CrankyZombie, July 7, 2024, running KDE.

ICYMI: SSH Server Bug Opens Vulnerabilities

https://privacysandbox.com/news/privacy-sandbox-update/
https://lifehacker.com/tech/google-reverses-decision-to-kill-cookies
https://lifehacker.com/tech/how-to-fix-crowdstrike-blue-screen-of-death
https://techcommunity.microsoft.com/t5/intune-customer-success/new-recovery-tool-to-help-with-crowdstrike-issue-impacting/ba-p/4196959
https://lifehacker.com/tech/fix-the-crowdstrike-bug-with-usb-drive


PCLinuxOS Magazine Page 22

by David Pardue (kalwisti)

GNU TeXmacs is a free/libre scientific document editor, designed to create 
beautiful technical documents using a WYSIWYG (What You See Is What 
You Get) interface. TeXmacs combines the advantages of LaTeX's 
premium document quality with the more intuitive interface of a word 
processor. In particular, the program is optimized for efficient input of 
mathematical formulas and for structuring mathematical documents.

The Confusing Name

Before discussing TeXmacs' features and history, I need to clarify one 
issue: the program's name. “TeXmacs” is misleading because it does not 
use TeX as its typesetting engine. It does not have any TeX-related 
dependencies; instead, the program uses custom typesetting algorithms 
(which are a rewrite of TeX algorithms with tweaks). In addition, TeXmacs 
is not based on Emacs (although you may select an Emacs “Look and feel” 
option.) It might be more accurate to say that (La)TeX and Emacs served 
as inspiration for GNU TeXmacs.

The choice of name has caused confusion over the years. Some people 
mistakenly assumed that TeXmacs was yet another distribution of TeX, 
tailored for macOS (like MacTeX). Other people have the misconception 
that the program is related to LaTeX and/or Emacs. In fact, there have been 
periodic discussions on the TeXmacs mailing list about changing the app's 
name. Some users favored the name JollyWriter (after the title of Joris van 
der Hoeven's book on TeXmacs). Typesetica was also suggested.

History

GNU TeXmacs was started by Joris van der Hoeven, an award-winning 
Dutch mathematician and computer scientist, in 1998. The program's first 
beta release was on Oct. 26, 1999. Although van der Hoeven is the primary 
developer, he is assisted by a multinational team of contributors which 
includes François Poulain, Miguel de Benito Delgado, Massimiliano 
Gubinelli, Darcy Shen and others. Dr. Van der Hoeven is committed to the 
idea of libre software; in TeXmacs’ help pages, he writes that “only free 
programs are acceptable from a scientific point of view.”

The program version in the PCLinuxOS repositories is 2.1.2 (released in 
May 2022). The current version is 2.1.4 (from April 2024), which was also 
released in AppImage format for the first time. I tested both versions of 
TeXmacs on my PCLinuxOS systems and they worked reliably. In the case 
of the 2.1.4 AppImage, just remember to first change the permissions on 
the file to make it executable:

GNU TeXmacs is multi-platform: Linux, macOS and Windows. The 
program is written in C++ and Scheme (a dialect of Lisp). It has its own 
file format (XML-like), and supports native output to PDF and PostScript. 
Built-in converters offer the capability of exporting to LaTeX format (.tex) 
as well as HTML.
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Program Strengths

Undoubtedly, a highlight of TeXmacs is its typesetting quality; it produces 
documents which match the standards of professional publications. Indeed, 
printed TeXmacs documents are indistinguishable from those produced 
with LaTeX. The program includes special TeX Gyre fonts for 
mathematical typesetting and output: Bonum (similar to Bookman Old 
Style), Pagella (similar to Palatino), Schola (similar to Century 
Schoolbook) and Termes (similar to Times New Roman). The fonts Linux 
Libertine, Linux Biolinum and Fira (a humanist sans-serif typeface) are 
also bundled by default.

GNU TeXmacs has less of a learning curve than LaTeX. If you are a 
beginner or non-programmer who does not want to wrangle with LaTeX 
markup, TeXmacs can save you time and effort. The editor is WYSIWYG, 
so there is no need to compile your document — as in LaTeX — nor is a 
separate window required to display your typeset document.

TeXmacs enthusiasts believe that the program provides a better user 
experience than LaTeX because everything you need is available in the UI. 
This makes it easier to concentrate on your writing, to focus on “content 
over code.” If you have ever tried LyX, you will notice some similarities 
between it and TeXmacs.

Like LaTeX, GNU TeXmacs allows you to easily produce structured 
documents and to semi-automate some writing tasks — such as generating 
a table of contents, labeling and numbering sections, figures and/or 
equations, managing references and creating bibliographies. For reference 
management, the bibliography must be in BibTeX format (.bib). (I am 
writing a follow-up article which describes how to create a bibliography 
and add citations in TeXmacs, since some readers are probably unfamiliar 
with BibTeX and a LaTeX-style bibliography management system.)
Image at right.

Math Typesetting

If you are a mathematician or scientist needing to incorporate many 
equations/formulas into your papers, GNU TeXmacs merits a closer look. 
The program allows you to type (and edit) math formulas quickly and 
naturally; they appear immediately in finished form. Joris van der Hoeven 
recorded a video tutorial which demonstrates how to type basic 
mathematical formulas. I learned that one area in which TeXmacs is 
popular is in teaching mathematics to high-school students and university 
undergraduates.

Another of GNU TeXmacs´ development principles is that with the advent 
of a wide variety of mathematical software, it should be possible to make 
documents more interactive. The program's functionality can be further 
extended via plugins for external computer algebra systems and packages 
such as Octave, Maxima, Axiom, Mathematica and Mathemagix. These 
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interfaces can be used in either shell-like sessions, inside spreadsheets, or 
on the fly inside regular text.

Additional Features

TeXmacs also includes an editor for creating graphical pictures, a 
presentation mode and a rudimentary spreadsheet facility.

The program's usefulness extends beyond writing mathematics. TeXmacs 
has enabled writers to produce articles, theses (up to approximately 150 
pages in length), as well as books. It can also be used for lecture notes, 
personal notes and plans, letters, presentations, résumés — and webpages. 
(The TeXmacs website is maintained as TeXmacs documents, then 
exported to HTML.)

User Interface

A nice feature of GNU TeXmacs is its context-sensitive user interface. The 
menus and toolbars depend on the cursor position. There are three toolbars:

 • A main toolbar
 • A “mode-dependent” toolbar
 • A “focus” toolbar (The smallest in size)

As an example of context-sensitivity, when you edit a table, TeXmacs 
automatically displays additional icons for inserting and manipulating table 
cells (right, top):

Disadvantages

GNU TeXmacs does not lend itself to collaborating with others, if they are 
LaTeX users. Although you can export your project as a .tex file and the 
generated file's code is usually clean, it might still require tweaking. 
Therefore, you need some knowledge of LaTeX to correct file anomalies. 
(The same is also true of LyX.)

If you are in academia, TeXmacs is not mainstream. There is an 
expectation of LaTeX proficiency because it is the de facto standard — 
especially in mathematics. (I have read online discussions suggesting that 
the requirement for journal submissions in TeX format is part of the peer 
review process. It is a filter that serves to discourage “non-serious” 
submissions.)

Repo Review: GNU TeXmacs
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However, the goal of the TeXmacs project is not to be another front-end for 
LaTeX, nor to be 100% interoperable with LaTeX. TeXmacs is its own 
ecosystem. Some TeXmacs users adopt a mixed usage approach; they write 
a quick draft with TeXmacs (saving time by skipping LaTeX markup), then 
use LaTeX for the document's final version.

Mogan Research (Fork)

For the curious and the early adopters, there is a fork of GNU TeXmacs 
called Mogan Research, which is updated more frequently than TeXmacs. 
Mogan Research and TeXmacs can be regarded as the same kind of 
product, released by different teams.

The program is developed by Darcy Shen and named for Mount Mogan 
(Mògān Shān in pinyin), a famous natural attraction in the province of 
Zhejiang, China.

Additional Resources

If you are interested in learning more about TeXmacs, excellent 
documentation is available. I found the resources listed below to be 
helpful.

To watch TeXmacs in action, there is a quick three-minute tour (with 
captions and a swinging jazz manouche soundtrack):
https://www.youtube.com/watch?v=H46ON2FB30U

From within GNU TeXmacs' help pages:

The Welcome section (from the Help menu > choose Welcome):

The brief “Getting Started with TeXmacs” guide (Help > Getting started).

Some written tutorials may be accessed on TeXmacs' official website:

https://www.texmacs.org/tmweb/help/tutorial.en.html

Although the definitive guide to TeXmacs is The Jolly Writer book 
(Scypress [2020], €49) by Joris van der Hoeven, a slightly older version 
(2019) of the manual can be downloaded as a PDF file, or consulted in 
HTML format.

If you prefer video tutorials, the TeXmacs Videos channel on YouTube has 
several good demonstrations (recorded in 2019 by Dr. Van der Hoeven 
himself).

Linux is Our Passion
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There is also an active GNU TeXmacs user forum:
http://forum.texmacs.cn/

Summary

GNU TeXmacs is an impressive example of high-quality FOSS software. 
The program is mature and stable. During my experiments, I used the 
AppImage for v. 2.1.4 almost exclusively. The only trouble I had was self-
inflicted (changing internal font settings by mistake); TeXmacs refused to 
launch. The problem was easily solved by deleting my ~/.TeXmacs 
directory, as suggested in the Troubleshooting section of the FAQ.

If you want to produce nice-looking PDFs, are a non-programmer, need to 
include mathematical equations, do not collaborate with LaTeX co-authors, 
and you want a gentler learning curve than LaTeX requires, TeXmacs is 
well worth your time to check out. GNU TeXmacs simplifies document 
creation by integrating the advantages of LaTeX with the user-friendly 
environment of a word processor.

The PCLinuxOS MagazineSpecial 
Editions!

Get Your Free Copies Today!
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Compiled by Meemaw

Strangers Attend Veteran’s Funeral

U. S. Marine veteran Gerry Brooks passed away 
at the age of 86 on May 18. Even though he had 
a few relatives, no one stepped up to arrange his 
funeral. The funeral home did it, and sent out a 
request for pallbearers and attendees, so the 
funeral could be done. Within minutes of 
posting the request, they had to start turning 
away pallbearer volunteers, as so many had 
called in.

Patriot Guard Riders, a volunteer organization 
that attends the funerals of U.S. veterans and 
first responders, escorted the hearse for 40 miles 
from the funeral home on motorcycles. 
Members of the Veterans of Foreign Wars 
(VFW) organization performed a 21-gun salute 

as volunteers held American flags and a crane 
lifted a giant flag at the entrance of the cemetery.

Hundreds of people attended the funeral, 
including his son, granddaughter, and son-in-
law. 

“It renews your faith in humanity,” Katie 
Riposta, the funeral director, said. “It sounds 
like he was a good person, but I know nothing 
about his life,” she continued, saying that a 
woman contacted the funeral home to say that 
Brooks’ had taken her in when she had nowhere 
else to go. 

“It doesn’t matter if he served one day or made 
the military his career,” Riposta said. “He still 
deserves to be respected and not alone.”

Florida Brothers Help Multiple People in a 
Fiery Car Crash

Florida brothers Christian and Dillon heroically 
helped multiple people involved in a fiery, fatal 
car crash. In the middle of the bridge, a truck 
pulled to the side, and in front of that, they saw a 
smashed car, a car on fire and a truck that had 
turned over. 

They ran to the truck to help those people out 
and then to the smashed car. A 55-year-old man 
and a 15-year-old girl who were riding in the 
pickup truck were hospitalized with minor 
injuries, as well as a 26-year-old man in the 
smashed car. The police hadn’t announced the 
victim in the car on fire, or disclosed the cause 
of the accident.

The brothers expressed the hope that if they 
were ever in that kind of trouble, someone 
would step up to try to help them.

“You have to kind of give yourself a pep talk and 
think, ‘If this were me, I hope somebody would 
help me,'” Christian said. “Your life can be over 
in a second. That was almost us. We were quite 
literally one car away from it all.”

“I would say, if you’re able to help, then help,” 
Dillon added.

Officers Save Newborn With No Heartbeat

Two policemen in Alexandria, Virginia, revived 
a newborn in the tense moments after he was 

Good Words, Good Deeds, Good News
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born not breathing. The 9-1-1 call stated that the 
other had just given birth, and that the baby 
seemed lifeless. When they responded, they 
found him not breathing and having no 
heartbeat.

Their training kicked in, and one officer began 
administering CPR, while the other officer tried 
to keep the parents calm. After two rounds of 
CPR, he found a pulse, and the baby “started 
fussing”. The officer added, “It felt amazing to 
hear him cry. In that moment, all the stress and 
fear of the situation just left me.”

The baby and his mother are doing well and 
have since returned home after a short stay in 
the neonatal intensive care unit (NICU).

Neighbors Save Drowning Child

A little boy is alive thanks to community 
members near Boston, Massachusetts, who were 
there when he desperately needed help.  9-1-1 
was called, saying that there was a child who

had drowned in a park pond. The fire 
department said that bystanders had pulled him 
out of the water and that he was unresponsive.

Community members there had CPR training, 
and gave the four-year-old CPR. When the 
firefighters arrived, he was breathing. However, 
a 10-year-old girl had seen the boy under the 
water and pulled him onto the shore. He was 
taken to a nearby pediatric trauma center after 
being stabilized. There was no report on his 
condition.

The 10-year-old girl was also credited for saving 
his life, along with all those involved in reviving 
him.

Hero Dog Saves 38 Others

A 10-year-old Basset Hound ran away from the 
home she was living in. When officials found 
her wandering, they had her checked to see if 
she had a chip, which she did. It turns out the 
home she ran away from was neglecting the 
animals there, and her running away saved the

animals that were still there — 36 dogs, a cat 
and a chicken.

She has been named Hero Salvare (the last name 
meaning to save and protect). The Humane 
Society in South Carolina described the 
conditions at the home, saying that the animals 
were in small cages, with filth everywhere, and 
some of them had untreated injuries.

The Humane Society took in 15 of the dogs 
themselves, including Hero, with several other 
smaller animal rescues taking in the others. 
Members of the community pitched in to help 
cover medical and other expenses for the 
rescued animals. Many of the dogs, including 
Hero, have been adopted now.

Primary Cause of Lupus Discovered–and A 
Possible Way to Reverse It

A team of scientists from Northwestern 
Medicine and Brigham and Women’s Hospital 
have identified the cause of lupus, a devastating 
autoimmune disease that affects 1.5 million 
Americans.

Good Words, Good Deeds, Good News
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The researchers first studied lupus patients and 
found that those with the disease had higher 
levels of an infection-fighting protein called 
interferon and not enough aryl hydrocarbon 
receptor (AHR), which regulates how the body 
responds to infection.

The team aims to develop medications to 
activate the AHR pathway. When this pathway is 
insufficient, it results in too many immune cells 
that promote the production of disease-causing 
autoantibodies.

“We found that if we either activate the AHR 
pathway with small molecule activators or limit 
the pathologically excessive interferon in the 
blood, we can reduce the number of these 
disease-causing cells,” said a researcher. “If 
these effects are durable, this may be a potential 
cure.”

Lupus effect on the skin
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by Paul Arnote (parnote)

Right up front, let me just state that I don’t own an “i” anything. No iPad. 
No iPhone. No iPod. Nope. Nothing preceded by an “i.” The closest I ever 
came was when I bought my wife an iPod Shuffle when they first came 
out, and that was years ago (they have been discontinued long ago).

And, until just a few weeks ago, I had never even heard of HEIC graphics 
files. Believe it or not, these two things are connected. You’ll see the 
connection here in a few minutes.

What Are HEIC Images?

I definitely had to do some exploring here, having never heard of or 
encountering HEIC images.

Just like WEBP graphics use the compression technology of the VP8 video 
codec to create high quality still images that are absolute misers when it 
comes to file size, HEIC images use the H.265 video compression codec 
from the Motion Pictures Experts Group to create high quality still images 
with impressively small file sizes. You can see our coverage of WEBP 
graphics here.

The HEIC format was formally “finished” in 2015 by “the Group,” and 
Apple adopted it in 2017. Today, unless the “i” user has changed the 
defaults, all images taken by a current iPhone or iPad are saved in the 
HEIC format.

While it's easy to see or understand why Apple is/was attracted to the 
HEIC format due to its high image quality and small file sizes, it does 
create a problem when an “i” user attempts to share images with someone

who isn’t a member of the “i” club. Adoption and support for the HEIC 
format is NOT universal, at least not yet.

To somewhat complicate things more, HEIC isn’t so much of a file format 
as it is a container format. If you’re not sure what a container format is, 
they’ve been with us for a while. Think of interleaved audio and video files 
(the “rest of us” used to call them AVI files, back in the day). Within that 
container, both the audio and video portions of the file are capable of being 
compressed by different codecs, and then the data is stored in the AVI 
container in such a way that it can be easily and properly put back together 
by the player when it comes time to play the AVI file back.

From Wikipedia:

HEIF is a container format, it can contain still images and image 
sequences that are coded in different formats. The main filename 
extensions are .heif for still images and .heifs for sequences, which can 
both be used with any codec. Generic HEIF image files are typically stored 
with filename extensions .heif, but they may use a different extension to 
indicate the specific codec used.

HEIF means High Efficiency Image Format. So, the way that Apple is 
utilizing the HEIC format is for storing images. HEIC, in the way that 
Apple is using it, means High Efficiency Image Codec. HEVC, in the way 
that Apple is using it, means High Efficiency Video Codec. For the latter, 
the “rest of us” call it H.265 encoded video.

Granted, the HEVC format (H.265) is quite adept at storing high quality 
video in some of the smallest file sizes I’ve ever encountered. If you want 
or need to explore HEVC farther, we’ve covered them in the past. You can 
view Archie’s solution to converting his video files to HEVC here, in the 
March 2021 issue of The PCLinuxOS Magazine. So, much in the way that 
WEBP files leverage the compression techniques of the VP8 video codec 
to produce smaller, high quality still images, HEIC leverages the
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compression techniques of the H.265 video codec to produce smaller, high 
quality still images.

In the way that Apple is using the image format, that image can contain the 
same image at different resolutions, images stored in different formats, or a 
sequence of images, all wrapped up in the container format. The end user 
can then extract which of those images or image sequences they want/need 
to use, provided that the tool the user is using is capable of extracting them. 
If that makes your head spin a bit, do not feel alone. I experienced the very 
same feeling. It’s a lot to wrap your head around.

I should at least explain how/why I went down this “rabbit hole.” I 
originally saw an article on Lifehacker about how to view or convert HEIC 
files on Mac or Windows. To be perfectly honest, that was the very first 
time I had heard about HEIC files. So, that got me thinking, “What about 
Linux?” This article is a result of going down that rabbit hole.

The Lifehacker article explains how to make your iPhone or iPad share 
images with other platforms that are more easily viewed. Their article also 
instructed those “i” users on how to change the default from HEIC to JPG 
(although I wouldn’t take that route, and forfeit the advantages that HEIC 
files provide … higher image quality at smaller file sizes).

That article also suggests using online graphic file converters to convert 
HEIC files to a format that is more easily viewed (and much more widely 
accepted). However, I wanted to avoid that situation altogether, fearful that 
this particular solution won’t settle well with a lot of users who go out of 
their way to preserve their privacy. And, I can’t say I blame them, with 
every entity on the web (it seems) wanting to extract its ounce of personal 
and private information. Being able to convert them on your own 
computer, without uploading anything online, is the best solution that helps 
preserve user privacy.

The file size savings for the HEIC format are HUGE. Compared to JPG 
files, HEIC images offer far better resolution, at file sizes that represent 
very significant savings in storage space. For the sample HEIC image used 
below, it comes in at 1.5 MB in file size. Converted to JPG, the same file 
takes up 2.3 MB of storage space. As a PNG file, the image comes in at 

13.4 MB. And, as a WEBP file, the image comes in at a very comparable 
1.3 MB.

How To View HEIC Images

Some operating systems now come with (or easily facilitate) the viewing of 
HEIC files. Windows 10 users can view them if they are running release 
1803, provided the user has installed the HEIF Image Extension. Windows 
11 users have the ability to read HEIC files built-in, from version 22H2 and 
later. MacOS from High Sierra and after has the ability to read HEIC files. 
iOS users can read and write HEIC files from iOS 11 and later. Android 
users from Android 10 and later can read HEIC files. As for Linux, it 
appears that it’s more driven by what software you use, as opposed to a 
system-wide ability to view HEIC files.

As for software on PCLinuxOS that is capable of displaying HEIC files, 
those software programs include GIMP, Krita, ImageMagick, 
DarkTable, GPicView, Shutter and Ristretto. For what it’s worth, 
GPicView did not properly display the HEIC file initially. But, upon a 
subsequent attempt (I was attempting to show how things look in a 
program that doesn’t support viewing HEIC files), GPicView displayed 
them perfectly. I have *no* idea why it failed the first time. The real 
“heavyweights” here are GIMP and ImageMagick. With those two alone, 
there is no problem viewing, creating or converting HEIC files.

As for web browsers, ONLY Apple’s Safari is capable of displaying HEIC 
images.

Meanwhile, I’ve found (mostly by trial and error) that mtPaint and 
XnViewMP are incapable of properly displaying HEIC images. I’m certain 
that there are other graphics viewers incapable of properly displaying 
HEIC images, but I’m not prepared to install every graphics viewer in the 
PCLinuxOS repository just to find out which ones display HEIC images 
and which ones don’t.
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Some HEIC Examples

What would an article about a “new” image format be without some 
examples? Even with a leisurely search, it’s relatively easy to find some 
HEIC image samples.

Here is a HEIC image loaded into GIMP:

Here is the same HEIC image loaded into Krita:

Here is Ristretto viewing the same HEIC image:

Here is GPicView displaying that same HEIC image:
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And, here is Shutter displaying the same HEIC file:

Meanwhile, below is what you see trying to open a HEIC file in mtPaint:

The image below is similar to what you might see if an image viewer 
doesn’t properly support the viewing of HEIC files (and this is what I saw 
the first time I loaded up a HEIC file in GPicView). For this, I used 
ImageMagick’s display command (but, ImageMagick DOES support 
HEIC files, so don’t misinterpret this to mean that ImageMagick doesn’t 
support them … it just means that the “display” command doesn’t support 
HEIC files). I have used my Image Converter script (March 2023 issue), 
which leverages ImageMagick for the “heavy lifting,” to convert HEIC 
files to JPG, PNG or WEBP files, and the script produces perfect results.

For what it’s worth, just inserting “heic” into line #5 of the aforementioned 
script, right after “webp” and before “avif,” adds the conversion to/from 
HEIC image files to the script. Easy peasy!

The improper display of colors is one of the first things you might notice, 
and is what I saw the first time I tried to view a HEIC file in GPicView.

Summary

To be perfectly honest, I have zero ideas of why Apple chose to support 
HEIC over WEBP. At least WEBP graphics are displayable by most top-
tier web browsers, and have found a greater and wider range of acceptance 
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among users on different platforms. While “this” 
is only conjecture, I suspect it may have 
something to do with Google buying up On2 
Technologies (the makers of the VP8 codec), 
and Apple not wanting to tie its fortunes to 
something owned and controlled by Google, 
despite WEBP being released for free usage. The 
“climate” between Apple and Google hasn’t 
always been “clear skies” or “clear sailing.”

With millions (possibly billions) of “i” devices 
in use, and with every “i” device saving images 
in the HEIC image format by default, it’s only a 
matter of time before we see much wider 
support for HEIC images.

Still, the image quality from HEIC images is 
easily on par with that produced by WEBP 
graphics, and the file sizes are quite small.

While I don’t have a lot of confidence in the 
MPEG folks (they are the ones who also came 
up with JPEG2000, JXL and multiple other 
formats that have failed to gain traction), HEIC 
images will eventually gain traction as more and 
more of them proliferate from users of “i” 
devices.

SSccrreeeennsshhoott  SShhoowwccaassee
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by davecs (Dave Spagnol)

I am really happy that the development of the 
Xfce Calendar program, Orage, was started 
again with Xfce 4.18. I was never sure why it 
was abandoned in Xfce 4.16, as the basic 
program hasn’t really changed, it just needed to 
link to more modern libraries. But I’m not a 
programmer, so what do I know?

Orage can be run as a standalone appointments 
calendar, which stores its data in ICS format. 
Where it becomes really powerful is in 
conjunction with a background program called 
vdirsyncer. This enables data to be exchanged 
with online services such as Google Calendar. I 
have updated the article I wrote on that, to take 
into account Google’s changes in OAuth.

Installing Orage is simple enough in most Linux 
distros, just go to the package installer, and find 
it in the “Stable Repo” tab and install!

Despite originally depending on the Xfce panel, 
nowadays, this will run on pretty much any 
desktop. When you run Orage, there is a setting 
under Edit > Preferences > Calendar Window > 
Calendar Visibility which enables you to see an 
icon in the System Tray, which will show the 
day of the month. This way it will run in the 
background, and when you click on the icon, the 
Orage window will alternately appear/disappear. 
But in Xfce (and also with the LXDE panel and 
some others), you can attach it to a panel clock, 
which is much nicer in my view.

Attaching Orage to the XFCE panel clock:

From Xfce version 4.18, and with some other 
panels, Orage can be attached to the panel clock. 
With systems based on Debian Stable, it can 
take a little work. Both Texstar’s PCLinuxOS 
and the Debian Edition have an up-to-date 
version of Orage, and the command orage -t 
works as it should. However some Debian-based 
distros may have an earlier version where orage 
-t doesn’t run orage if it’s not running already. 
Here is a script that will take care of it:

#!/bin/bash
pidof orage >/dev/null && orage t 
|| orage

I called it orage-flip and saved it as root in /usr/
local/bin — you also need to change its 
properties so that it is executable. On up-to-date 

versions, you don’t need the script and you only 
need to put orage -t as the command to run 
when the clock is clicked. To test which version 
you have, just run killall orage followed by 
orage -t from a terminal and see what happens. 
If orage runs, you don’t need the script and just 
use orage -t.

Orage Calendar Settings Window

Since you will be making Orage appear and 
disappear when you click on the clock, you 
don’t need it to show in the taskbar or the 

Running Orage From Your Panel Clock
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systray. If you are using the orage-flip method, 
set the calendar window preferences as shown.

XFCE 4.18 Clock Properties setting window.

In order to run Orage when you click on the 
panel clock, all you have to do is to right-click 
on the clock, select Properties, and put the 
command in the box as shown on the left. Either 
orage-flip or orage -t.

Next Month, we will be showing how to link 
Orage to your Google Calendar.

 
(We’d like to thank davecs for allowing The 
PCLinuxOS Magazine to reproduce this article 
from his blog, at https://
davespagnol.wordpress.com/2024/07/08/orage-
returns/)
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Editor’s Note: Tip Top Tips is a semi-monthly 
column in The PCLinuxOS Magazine. 
Periodically, we will feature – and possibly even 
expand upon – one tip from the PCLinuxOS 
forum. The magazine will not accept 
independent tip submissions specifically 
intended for inclusion in the Tip Top Tips 
column. Rather, if you have a tip, share it in the 
PCLinuxOS forum’s “Tips & Tricks” section. 
Occasionally, we may run a “tip” posted 
elsewhere in the PCLinuxOS forum. Either way, 
share your tip in the forum, and it just may be 
selected for publication in The PCLinuxOS 
Magazine.

This month’s tip was started by Seacht, and 
added to by others from the forum. Let’s try to 
distill it down from those various posts.

Here’s Seacht’s original post:

Recent changes to the UID used by default on 
PCLinuxOS ISOs have changed from 500 to 
1,000 for the first user created. Should you wish 
to change your existing user IDs, these two 
commands are useful.

As root:

To assign a new UID to an existing user:

usermod -u 1000 <username>

To assign a new GID to an existing group:

groupmod -g 1000 <groupname>

All files and folders in the user's home directory 
will automatically change the UID and GID. 
However, files and folders outside  ~/user will 
need to be changed manually.

That post led to a question from AnalogueMan 
about another command that Texstar had 
previously posted. Namely, that command from 
Texstar is:

chown -R username:username /home/
yourloginname.

Compounded image from Clker-Free-Vector-Images on Pixabay

Tip Top Tips: Change User Account UID & GID
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To answer AnalogueMan’s question, kjpetrie 
responded with the following:

That is an alternative command which works a 
different way in a different situation. Seacht's 
command is for changing the UID/GID of the 
existing system without reinstalling to bring it 
into line with the ISOs and prevent having to use 
Texstar's command if you do subsequently need 
to reinstall.

Texstar's command is for use after reinstalling if 
your files still have the old IDs, though there is 
the alternative of using Seacht's command the 
other way round to restore the system to the 
previous IDs.

So it's either one or the other, but usually not 
both.

There are subtler issues if you've set up multiple 
users and groups to maximize your use of UNIX 
permissions, but if you've done that, you will 
have the knowledge to work out your best way to 
restore the intended access after reinstalling.

Armed with that information, AnalogueMan 
attempted to execute Seacht’s commands, after 
using su - to switch to the root user. Something 
went awry.

tbs chimed in that it will work much better to 
open a virtual tty window (Ctrl + Alt + [F1-F7]), 
log in as the root user, execute the commands, 
and then reboot. When you log back in, your 
userid and groupid should both be set to the 
current user and group ID of 1000. To return to

the GUI interface of PCLinuxOS, press a 
combination of the Ctrl + Alt + F8 keys.

Keep in mind that Seacht’s command ONLY 
works on files stored in the user’s /home 
directory. As bliss and Gerrit Draisma pointed 
out, any files on external drives (or any other 
files NOT stored in the user’s /home directory) 
will need to use a different command to change 
the ownership of those files. That command has 
to be entered as the root user, and it is:

chown -R username:username /path/to/
folder/you/want/to/change/permissions/
for

That led to another question by AnalogueMan, 
about why the PCLinuxOS installer update 
changed the UID and GID from 500 to 1000.

Seacht had the answer:

“Most other Linux distros use IDs of 1,000 and 
up, so changing PCLOS allows user files to be 
read by other distros, and [the] PCLinuxOS user 
to read other distro user files, without the 
necessity of changing ownership.”

And that, as the legendary broadcaster Paul 
Harvey was famous for saying, is the REST of 
the story!

Support PCLinuxOS!
Get Your Official

PCLinuxOS Merchandise
Today!

DOWNLOAD

Mate Desktop

Tip Top Tips: Change User Account UID & GID
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INGREDIENTS:

1 pound ground beef
1 packet Lipton Onion Soup Mix
4 1/2 cups water
1 pound bow tie pasta
10 ounces cream of mushroom soup
3/4 cup sour cream

INSTRUCTIONS:

Brown the ground beef and then drain off fat in 
a large skillet that has a lid. Add the onion soup 
mix and water and mushroom soup mix (if you 
want). Mix well and bring to a boil.

Add the Bow Tie pasta and bring back to a boil. 
Reduce the heat to medium-high and cover. 
Cook for 10 -12 minutes. Take off heat and 
gently stir in the sour cream. Enjoy this quick 
and delicious version, and you won't go back to 
the box. If you would like to make more of a

meal out of this, add some fresh broccoli or 
other vegetables.

TIPS:

I suggest that you can go up to 2 pounds of 
ground beef if you really want a heartier dinner. 
You may also want to add a couple of small cans 
of mushrooms to this recipe. You may also want 
to switch the soup recipe for the Mushroom 
Soup with Roasted Garlic variety. It would work 
well too!

If you want a cheesy dish, use cheese instead of 
sour cream. Throw in some diced tomatoes and 
really enjoy something nice!
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Hamburger Helper Type Beef Stroganoff
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SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can 
view them here. You have seven (7) letter 
tiles with which to make as long of a word 
as you possibly can. Words are based on 
the English language. Non-English 
language words are NOT allowed.
2. Red letters are scored double points. 
Green letters are scored triple points.
3. Add up the score of all the letters that 
you used. Unused letters are not scored. 
For red or green letters, apply the multiplier 
when tallying up your score. Next, apply 
any additional scoring multipliers, such as 
double or triple word score.
4. An additional 50 points is added for 
using all seven (7) of your tiles in a set to 
make your word. You will not necessarily 
be able to use all seven (7) of the letters in 
your set to form a “legal” word.
5. In case you are having difficulty seeing 
the point value on the letter tiles, here is a 
list of how they are scored:
  0 points: 2 blank tiles
  1 point: E, A, I, O, N, R, T, L, S, U
  2 points: D, G
  3 points: B, C, M, P
  4 points: F, H, V, W, Y
  5 points: K
  8 points: J, X
  10 points: Q, Z
6. Optionally, a time limit of 60 minutes 
should apply to the game, averaging to 12 
minutes per letter tile set.
7. Have fun! It's only a game!

SUDOKU RULES: There is only one valid solution to each 
Sudoku puzzle. The only way the puzzle can be considered 
solved correctly is when all 81 boxes contain numbers and the 
other Sudoku rules have been followed.

When you start a game of Sudoku, some blocks will be pre filled 
for you. You cannot change these numbers in the course of the 
game.

Each column must contain all of the numbers 1 through 9 and 
no two numbers in the same column of a Sudoku puzzle can be 
the same. Each row must contain all of the numbers 1 through 9 
and no two numbers in the same row of a Sudoku puzzle can 
be the same.

Each block must contain all of the numbers 1 through 9 and no 
two numbers in the same block of a Sudoku puzzle can be the 
same. D
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Possible score 261, average score 183.

PCLinuxOS Puzzled Partitions
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PICNIC TABLE        LAWN CHAIRS
BENCHES        CAMPFIRE
PIECE OF CAKE        CAMPSITE
STRAWBERRY        SHORTCAKE
S'MORES        TABLES
HOMEMADE ICE CREAM
SLOPPY JOE        POTATO SALAD
LAWN CHAIR        FAMILY
COOLER        PLATES
SILVERWARE        DRINK
GRILL        CAMPGROUND
PARK            SHELTER
TABLE        BARBECUE
RECREATION        PLAYGROUND
GRIDDLE        BACKYARD
POOL        BALLGAME
HOT DOGS        WATER
BANDSTAND        FINGER FOOD
VOLLEYBALL        SOFT DRINKS

        HAMBURGER

Download Puzzle Solutions Here
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1. A structure that provides cover or protection, as
    from the weather.
2. An outdoor platform, often roofed, for people to
    enjoy a musical group’s performance.
3. Small types of food that can be eaten without the
    use of silverware.
4. A flat metal surface, such as a pan, that is used
    for cooking.
5. A piece of ground used for recreation, especially
    containing equipment such as slides or swings.
6. Refreshment of ones mind or body after work
    through activity that amuses or stimulates; play.
7. A type of cooking equipment where the cooking
    surface consists of an open rack or grate with a
    heat source underneath.
8. An area used for setting up tents or vehicles to
    sleep in.
9. Confection made from graham crackers,
    marshmallows, and chocolate bars.
10. A bun filled or covered with ground beef cooked
     in a spicy tomato sauce. 
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